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Introduction
 
 
 
 

Outlook 2003 has features to allow you to share items with other Outlook 2003 
users. You can give others access to see or modify your calendar, process your mail, 
or manage tasks. You can also recall messages and see the global address list of 
other campus email users. 
 
 
 

Getting Help If you experience problems using Outlook 2003, you can obtain help from several 
online sources: 

• Office Assistant 
• Help Contents and Index 
• Microsoft® Web Site 
 

If you are unable to resolve an issue, call the helpdesk (x7419) or your computer 
support professional in Institutional Computer Services (Academic – Kay Carlisi ( 
x7379);  Administrative –  Bonnie Rands (x7435) or John Taylor (x7221). 
 
 
Office Assistant 

When you need to ask a question, you can ask the Office Assistant. You can also set 
the Office Assistant to automatically provide tips and help while you work. The 
Office Assistant works with all the Office programs, and can be customized to meet 
your work style.  
 

 
Office Assistant 

To access the Office Assistant, click Help, Show the Office Assistant. The Office 
Assistant appears, and you can type your question.  You can also access tips or set 
the options of the Office Assistant. 
 

 
Office Assistant 
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Contents and Index 

Help Contents and Index 

When you want to look for a general topic or browse through Help’s table of 
contents, use Help Contents and Index. To access Help Contents and Index, click 
the Help pull down menu and select Microsoft Office Outlook Help. 
 
Microsoft® Web Site 

Microsoft® maintains a section of their web site for Outlook™ users. The web pages 
contain tips, tools, patches, and articles. Access the Microsoft® Outlook™ web 
pages by opening the following address in your web browser: 
 

http://www.Microsoft.com/Outlook 
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Sharing 
Information
 Would you like a group of people to view your calendar or the files in one of your 

folders? Do you want to allow your assistant to process the mail and appointments 
in your Inbox and Calendar? You can do these things by sharing the private folders 
listed under Mailbox – Your Name or by making someone a delegate. The following 
table explains these options: 
 
Use When  Example 

  
Shared folders You want to give one or 

more persons permission to 
read, modify, create, or 
delete information in your 
private folders. 
 

You want a colleague to see 
your task list, or you want 
your supervisor to see your 
schedule. 
 

Delegate Access You want to give someone 
permission to send 
messages on your behalf, 
accept meeting and task 
requests for you, or manage 
information in your private 
folders. 

You have an assistant who 
helps you manage your 
email messages and your 
schedule while you're out of 
the office. 

 
The following sections outline these two methods of access. 
 
 

Sharing Folders 
 
 

You can share any folder that is listed under Mailbox – Your Name in Outlook™. 
This includes Inbox, Calendar, Task List, or any folder you personally create.  You 
cannot share folders listed as a Personal folder unless you move them under your 
mailbox. To share a folder, follow these steps: 
 

 
 

 
 
 
 
 
 

 
 
 
 
 

Share a folder 

1. If the All Mail Folders list is not visible, select View then Navigation Pane.  
2. Right-click the folder you want to share, and then click Properties on the 

shortcut menu.  
The Properties window appears. 

3. Click the Permissions tab. 
4. Click Add. 

The Add Users window appears. 
5. In the Type name or select from list box, enter the name of the person you 

want to grant sharing permissions to, or select the person’s name from the 
list. 

6. Click Add, then click OK. 
The Properties window returns, and the person’s name is added to list. 

7. In the Name box, click the name of the person you just added. 
8. In the Roles box, select the permissions you want. See the table below. 
9. Click OK. 

The person is given access rights to your folder. 
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 The following table outlines the different permissions for sharing folders: 
 
In this role A person can 

Owner Create, read, modify, and delete all items and files and 
create subfolders. As the folder owner, you can change 
the permission levels others have for the folder. 

Publishing Editor Create, read, modify, and delete all items and files and 
create subfolders. 

Editor Create, read, modify, and delete all items and files. 

Publishing Author Create and read items and files, create subfolders, and 
modify and delete items and files you create. 

Author Create and read items and files, and modify and delete 
items and files you create. 

Reviewer Read items and files only. 

Contributor Create items and files only. The contents of the folder are 
not shown. 

Custom Perform activities defined by the folder owner. 

None No permission. Cannot open the folder. 

 

Accessing Shared 
Folders 
 

If a person gives you access to a folder, you can open the folder and work with the 
items according to your permissions. The following steps outline how to open a 
shared folder: 
 

 
 
 
 

 

Open a shared folder 

1. On the File menu, point to Open, and then click Other User’s Folder. 
2. In the Name box, type the name of the person who granted you sharing or 

delegate access permission, or click the Name button to select from a list. 
3. In the Folder box, click the folder you want to open. 
4. Click OK. 

The folder opens in a new window. 
 
Sometimes you may be unsure what you can do in another person’s shared folder. 
To check your permissions, follow these steps: 
 
Check your permission status on a shared folder 

1. Open the shared folder you want to check the permission status for. 
2. On the File menu, point to Folder, and then click Properties for folder. 
3. Click the Summary tab. Your permission level appears under Your 

permissions. If the Permissions tab appears instead of the Summary tab, you 
have owner permission. If neither tab appears, you do not have permission to 
change the folder properties. 

 
 

Sharing Mailbox 
Folder 

You may wish to give others access to your Mailbox. This would allow others to 
add your mailbox to their profile, causing their folder list to include your Mailbox.  
After giving others access to your Mailbox, you must also give them access to your 
subfolders. For example, you could give someone access to your Mailbox and 
Inbox. That person could then add your Mailbox to his or her folder list, which 
could be expanded to show your Inbox. 
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Share your mailbox folder 

1. If the Folder List is not visible, select View then Folder List. 
2. Right-click the mailbox folder you want to share, and then click Properties 

on the shortcut menu. 
3. Click the Permissions tab, and then click Add. 
4. In the Type name or select from list box, enter the name of the person you 

want to grant share permissions to. 
5. Click Add, and then click OK. 
6. In the Name box, click the name of the person you want. 
7. In the Roles box, select the permissions for the delegate. 
8. Click OK. 

The person now has access to your mailbox. 
 
Add another person's mailbox to your user profile 

To list another’s mailbox in your Outlook™ at all times, you must first be given 
permissions to that folder. Then complete the following steps from Outlook™: 

1. Click Inbox. 
2. On the Tools menu, click Services. 
3. In the The following information services are set up in this profile box, click 

Microsoft Exchange Server. 
4. Click Properties, and then click the Advanced tab. 
5. Click Add, and then type the mailbox name of the person whose mailbox 

you want to add to your user profile and click OK twice. 
The mailbox is added to your Outlook™ screen. See the following 
illustration: 

 

 
 Additional Mailbox in Profile 

 
 

Delegating Access Just as you may have an assistant who helps you manage your incoming paper mail, 
Microsoft® Outlook™ allows you to have another person manage your electronic 
mail. This is called delegating access. 
 
Depending on their permissions, delegates can open your folders, create items, 
respond to requests, and send messages on your behalf. If the delegate has access to  
your Inbox, the delegate can reply to your mail on your behalf. Delegates can also 
organize meetings on your behalf and respond to meeting and task requests sent to 
you.  See the Send-on-behalf-of Permission section. 
 

 
 
 
 
 

Below are the steps to give others delegate access: 
 
Granting Delegate Access 

1. On the Tools menu, click Options, and then click the Delegates tab. 
2. Click Add. 
3. Enter the name of the delegate you want to set permissions for in the Type 

name or select from list box.

 
 

4. Click Add, and then click OK. 
The Delegate Permissions screen appears. 

FLCC Advanced Microsoft® Outlook™ 5 



To add multiple delegates 
simultaneously, select multiple 
names in the Add Users dialog box. 

5. Select the permissions for each Outlook™ folder you want your delegate to 
access.  

6. To send a message to notify the delegate of the delegate status and 
permissions you set, select the Automatically send a message to delegate 
summarizing these permissions check box. 

7. Click OK twice to return to Outlook 2003. 
The person is now a delegate. 

 
The following table outlines the different permissions for delegates: 
 
With this permission Your delegates can 

Author Read and create items, and modify and delete items 
you create. For example, a delegate can create 
meeting requests directly in the manager's Calendar, 
and then send it on the manager's behalf. 

Custom Perform activities defined by the manager. 

Editor Read and create items, and modify and delete any 
item. For example, a delegate can reply to messages, 
task requests, and meeting requests for the manager. 

Reviewer Read items only. For example, read messages in 
another person's Inbox. 

None No permission. Cannot open the folder. 
 
The following options overview special ways to configure Outlook 2003 delegates: 
 

• If you want your delegate to be sent copies of your meeting requests and 
responses, give the delegate editor permission and then select the Delegate 
receives copies of meeting-related messages sent to me check box on the 
Delegates tab (Tools menu, Options command). 

 
• A delegate must have editor permission in a manager's Calendar or Tasks 

folder and reviewer permission in the manager's Inbox to accept meeting or 
task requests for the manager. 

 
• If a manager selects the Send meeting requests and responses only to my 

delegates, not to me check box on the Delegates tab (Tools menu, Options 
command), then the delegate does not need reviewer permission in the 
manager's Inbox; the meeting requests and responses go directly to the 
delegate's Inbox. 

 
 

Using Delegate 
Access 

If you receive a verbal or electronic message that you have been given delegate 
access, you can open the folders you have permissions to (see the Open a Shared 
Folder section) or send items on behalf of the person who gave you access. For 
example, if your manager gave you delegated you as an author of his or her Inbox, 
you could open your manager’s Inbox or send email messages on behalf of your 
manager. 
 
Send-on-Behalf-of Permission 

With any delegate access permission listed above, delegates have send-on-behalf-of 
permission. This means that, as a delegate, you can add the From field (through the 
View menu) to email messages, and then send the messages on your manager's 
behalf. Messages sent this way contain both the manager's and delegate's names.  
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Message recipients see the manager's name in the Sent On Behalf Of field and the 
delegate's name in the From field. 
 
Messages can be sent from the delegate’s Inbox. And messages sent on behalf of 
another person contain both the manager's name and the delegate's name. Message 
recipients see the person's name who granted permission in the Sent On Behalf Of 
field and the delegate's name in the From field. 
 
Replies are sent to the delegate and not to the person who granted permission. Sent 
mail is saved in the Sent Items folder of the delegate, and message-tracking 
notifications are sent to the delegate. If the delegate has Outlook™ automatically 
record journal entries for particular items, and a sent-on-behalf-of item is one that 
will be automatically recorded, it is recorded in the Journal of the delegate. 
 
Send email with both the delegate's and manager's names 

1. On the File menu, point to New, and then click Mail Message. 
2. On the View menu, click From field. 
3. In the From box, enter the name of the person you are sending the message 

on behalf of. 
4. In the To, Cc, and Bcc boxes, enter recipient names. 
5. In the Subject box, type the subject of the message. 
6. In the text box, type the body of the message. 
7. Click Send. 

 
Reply to mail in the manager's Inbox on behalf of the manager 

1. Open the manager's Inbox. 
2. Double-click the mail message you want to reply to. 

The message opens. 
3. To reply to only the sender of the message, click Reply. 
 To reply to all recipients in the To and Cc boxes, click Reply to All. 
4. In the text box, type your response. 
5. Click Send. 

 
 

Private Information 
 
 
 

 
 

You may have some items you wish to keep private from delegates or others who 
can access your folders.  
 
Mark a Calendar, Task, Journal, or Contact item as private 

1. Open the item to mark private 
2. In the lower right corner, mark the Private check box. 

Delegates or others with permissions to open your folders can no longer 
view the item. 

 
Outlook™ has no way to mark notes or existing email items as private information. 
If you want these items to be private, you should move the item to a private folder 
no one has permission to access.   
 
For example, if you had a delegate processing your mail, but you received a 
message you didn’t want others to read, you could drag that message to a folder 
listed under Personal folders. Then no one would be able to access or read that item. 
 
A sender can mark an email message as private; then no one but the receiver can 
view the message. Follow these steps to mark a message you are sending as private: 
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 Mark an email message as private 

1. Create a new message and type the address and message. 
2. Select View then Options. 
3. In the Sensitivity box, select the Private option. 
4. Click Close. 

The Options window closes. 
5. Click Send. 

The message is sent and is private from everyone except the recipient. No 
delegates will be able to view the message.
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Email Options
  With Outlook™, you can see a list of all users in Outlook™, recall messages, and 

track mail delivery status. 
 

Recalling Email 
Messages 

If you send a message to a person with a flcc.edu address, you can recall that 
message. Recalling a message means the message is either deleted from the 
recipient’s mailbox or replaced by another message. 
 
You can only recall or replace messages you sent to recipients who are logged on,   
using Outlook™ and have Mailbox – Their Name listed, and have not read the 
message or moved the message out of their Inboxes. It may take several minutes to 
hours to recall a message from someone’s mailbox. If the recall process fails, an 
additional message will be sent saying that you tried to recall the message.  To 
recall a message, follow these steps: 
 

 
 
 

 
 
 
To replace a message, you must 
send a new one. If you do not send 
the new item, the original message 
is still recalled.

Recall a message 

1. Select View then Navigation Pane. 
The All Mail Folders list appears. 

2. Click Sent Items. 
3. Open the message you want to recall or replace. 
4. On the Actions menu, click Recall This Message. 
5. To recall the message, click Delete unread copies of this message. 
 To replace the message with another, click Delete unread copies and 

replace with a new message, click OK, and then type a new message. 
6. To receive a notification about the success of the recall or replacement for 

each recipient, select the Tell me if recall succeeds or fails for each 
recipient check box. 

7. Click OK. 
Outlook™ will attempt to recall the message. 

 
Global Address List 
 

The Global Address List contains all email addresses for users, groups, and 
distribution lists on the mail server. The administrator creates and maintains this 
address book.  
 
The list includes only people who have email addresses ending in flcc.edu. When 
you enter a name into the To field of a message, Outlook™ checks the entire list for 
a match to that name. 
 
To see the Global Address List, select Tools then Address Book.  The Address 
Book appears. In the Show names from the field, select Global Address List. The 
list of names and groups appears. 
 
 

Tracking Messages 
 

When sending e-mail to other Outlook users* on campus, you can track when 
messages you send are delivered or read by recipients. You receive a notification as 
each message is delivered or read. The contents of the notification are then 
automatically recorded on the Tracking tab of the original message. You can turn on 
or off automatic recording of tracking results and review each notification before 
the results are recorded on the Tracking tab. You can also automatically delete 
message notifications in your message list. 
 
*When sending to users off campus or other non-Outlook users, 
tracking features may not work. 
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Marking Delete receipts and blank 
responses after processing sets 
Outlook™ to automatically delete 
notifications of delivered and read 
messages and blank responses 
after they are opened.

Track an Individual Message 

1. Start a new email item, and type the message text. 
2. Select View then Options. 
3. In the Voting and Tracking options section, mark the desired tracking 

options. 
4. Click Send to send the message. 

 
Track All Messages 

1. Select Tools then Options. 
The Options window appears. 

2. Click the E-mail Options button. 
The E-mail Options window appears. 

3. Click the Tracking Options button and select the tracking options you 
desire. Click OK until all windows are closed. 
All future mail items will use these tracking options. 

 
Set How Messages Are Tracked 

To set how your messages are tracked, click Tools then Options and click E-mail 
Options. Then click the Advanced Email Options button. The following table 
outlines the available tracking options: 
 
With this option These actions happen 

Process requests and 
responses on arrival  

When responses or receipts arrive in your Inbox, 
Outlook™ automatically records the response in the 
original item. If this option is cleared, you will be able 
to review the responses in your Inbox before they are 
recorded. 
 

Process delivery, read, 
and recall receipts on 
arrival 

When notification messages arrives, Outlook™ 
automatically records the tracking results with the 
original item in the Sent Items folder. Any receipt of 
the delivery is automatically deleted. Open the item in 
the Sent Items folder and click the Tracking tab to 
view the tracking information. 
 

 
 
 
 
 

 
 

 
Review tracking results 

1. Select View then Folder List. 
The Folder List appears. 

2. Click Sent Items. 
3. Open the message you want to recall or replace. 
4. Click the Tracking tab then view the results. 
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Calendar  
Options
 
 

Outlook™ also has ways to interactively schedule meetings with other Outlook™ 
users. 
 
 

Meeting Planner Do you often wonder when would be the best time to hold a meeting according to 
other people’s schedules?  Outlook™ allows you to check other people’s schedules 
who are using the calendar listed under Mailbox – Their Name when you are 
planning a meeting. Then it will send an invitation to everyone for the meeting and 
keep track of who can and can’t attend the meeting. 
 
Schedule a Meeting 

When you schedule a meeting, Outlook™ actually sends the people on your list an 
email message asking if they can come. 

1. Make sure you are in Calendar. 
2. Select Actions then Plan a meeting. 

The Plan a meeting window appears.
 

 

 
 

If you don’t want to receive 
responses, unmark the Receive 
Responses option under the 
Appointment drop-down menu. 

 

 
 
 

 

3. To invite attendees and resources, click the Invite Others button. Select a 
name from the list. If you need to invite people not listed, click New… to 
add them. For each name entered, click Required, Optional, or Resources. 
Click OK. 

4. To have Outlook™ automatically choose a time, click the AutoPick button. 
Outlook™ will automatically choose a time according to everyone’s 
schedule. 
Or choose the meeting date and time manually. 

5. Click the Make Meeting button. 
A new appointment opens. 

6. In the Subject box, type a description. 
7. If you did not schedule a room, enter the location in the Location box. 
8. Select other options you want. 
9. If the meeting is recurring, select Appointment menu then Recurrence. 

Select the recurrence pattern and range of recurrence options you want. Click 
OK. 

10. Click Send. 
Meeting invitations are sent to all involved. 

 
After the meeting request is sent, you can track responses by clicking the Attendee 
Availability tab on the scheduled meeting in your calendar. 
 
You may need to cancel a meeting you organized. Follow these steps to cancel a 
meeting: 
 

 
 
 
 
If you do not send a cancellation 
notice, the meeting attendees will 
not know the meeting is canceled. 

Cancel a meeting you organized 

1. Open the meeting to cancel in your Calendar. 
2. Select Actions then Cancel Meeting. 

A new window appears. 
3. Select to send with or without a cancellation notice and click OK. 

The meeting is removed from your calendar. 
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 Publishing Free and Busy Information 

When others plan meetings, they may be able to view the times when you are busy, 
free or out of the office. To choose how much information is published about your 
calendar, select Options from the Tools pull-down menu and click the Calendar 
Options button. Then click the Free/Busy Options button. Choose a time period to 
publish your information. 
 
 

Responding to 
Meeting Requests 

When someone schedules a meeting, and you are invited to attend, you will receive 
an email message stating the time, date, and location of the meeting. 
 
At the top of the email message will be three buttons: Accept, Decline, and 
Tentative. 
 

 
 Meeting Buttons 

 
The following table lists actions you can take when you receive a meeting request: 
 
Choose When 

  
You want to accept the meeting and add it to Calendar. 

  
You want to tentatively accept the meeting and add it to 
Calendar. 

  
You wish to decline the meeting and not add it to 
Calendar. 

  
When you want to see the appointment in Calendar 
before responding. 

 
Changing your response 

If you want to change your response to a meeting request, right-click either the 
original email message requesting the meeting or the meeting on your calendar. A 
shortcut menu appears; select Accept, Tentative, or Decline.
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